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This chapter introduces the product overview, CODESYS software, networking application,

packaging list, appearance, buttons, indicators, interfaces and Supercapacitor.

The ED-PAC3630 is a real-time CODESYS programmable automation controller, pre-installed by

default with a multi-core CODESYS runtime. Depending on the application scenario and user

requirements, it offers programmable logic system configurations with either 2GB DDR + 16GB

eMMC  or ​8GB DDR + 32GB eMMC .

WARNING

The ED-PAC3630 device comes pre-installed with a valid CODESYS license by default.

Reinstalling the operating system will invalidate the CODESYS license. Do not attempt to

install the OS on your own.

The ED-PAC3630 provides common interfaces such as ​HDMI, USB, Ethernet, RS232, RS485, DI,

DO, and CAN. It integrates advanced features including a supercapacitor backup power supply, 

RTC (Real-Time Clock), Watch Dog, EEPROM, and an encryption chip, significantly enhancing the

product's usability and reliability. It is primarily designed for industrial control applications.

The ED-PAC3630 supports connection to remote EtherCAT-based I/O modules (e.g., couplers, DI,

DO, AI, AO) via an EtherCAT network. The device integrates the CODESYS Control Runtime

System, supporting IEC 61131-3 programming standards and industrial communication protocols

like EtherCAT and Modbus TCP. Users can optionally enable additional functionalities by licensing

features such as:

TargetVisu

WebVisu

Softmotion

CNC + Robotics

EtherCAT Master

Modbus TCP Master

OPC UA Server

Custom configurations are available to meet specific application requirements.

1 Hardware Manual

1.1 Overview

• 

• 

• 

• 

• 

• 

• 
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CODESYS (Controller Development System) is an open industrial automation software

development platform that provides a full-stack solution for programming, debugging, and

maintaining programmable logic controllers (PLCs), industrial PCs (IPCs), and embedded control

systems. Compliant with the IEC 61131-3 international standard, it supports complex logic control,

multi-axis motion control, industrial communication protocol integration, and real-time data

processing. It is widely used in smart manufacturing, energy management, logistics automation,

and other industrial fields.

Key Features of CODESYS:

Standardized Programming Language Support 

Full compatibility with the IEC 61131-3 programming languages: 

Ladder Diagram (LD)

Function Block Diagram (FBD)

Structured Text (ST)

Instruction List (IL)

Sequential Function Chart (SFC)

Supports Object-Oriented Programming (OOP) extensions for large-scale complex projects.

Cross-Platform Development & Deployment 

Development Environment: Compatible with Windows and Linux operating systems, offering

a unified engineering interface.

Target Systems: Deployable on 2,000+ industrial controller hardware platforms, including

ARM/X86 architectures.

Modular Engineering Libraries 

Prebuilt Libraries: Include industrial protocol stacks (Modbus/TCP, OPC UA, EtherCAT) and

advanced control modules (PID control, CNC interpolation algorithms).

Custom Libraries: Support encapsulation and reuse of Function Blocks and POUs (Program

Organization Units).

Visual Debugging & Diagnostic Tools 

Real-time monitoring of variables, I/O mapping, and task execution status with waveform

analysis.

Advanced debugging tools: breakpoints, step-by-step execution, and cross-referencing for

rapid fault diagnosis.

Integrated ​HMI development tools for seamless SCADA system integration.

The ED-PAC3630 supports CODESYS V3.5 SP19 and later versions.

1.2 ​Introduction to CODESYS Software
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The ED-PAC3630 features EtherCAT, Ethernet, RS485, RS232, DI, DO, and CAN interfaces,

enabling multi-layer network communication to meet diverse application requirements across

various scenarios. A typical application topology is illustrated in the figure below:

1 x ED-PAC3630 Unit

Introducing the functions and definitions of the interfaces on each panel.

Introducing front panel interface types and definitions.

1.3 Networking Application

1.4 Packing List

• 

1.5 Appearance

1.5.1 Front Panel
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NO. Function Definition

1 4 x green UART indicators, which is used to check the communication status of UART port.

2 1 x green user indicator, user can customize a status according to actual application.

3 1 x green system status indicator, which is used to view the status of system read/write operations.

4 1 x red power indicator, which is used to check the status of device power-on and power-off.

5 1 x green 4G indicator, reserving location (currently unused).

6 8 x green DI indicators, which is used to check the communication status of DI signal.

7 2 x green CAN indicators, which is used to check the communication status of CAN signal.

8 8 x green DO indicators, which is used to check the communication status of DO signal.

9 8 x DI ports, 10-Pin 3.5mm pitch phoenix terminals, which is used to connect third-party sensors.

10

2 x CAN ports, 6-Pin 3.5mm pitch phoenix terminals, which is used to connect third-party control

equipment.

11 8 x DO ports, 10-Pin 3.5mm pitch phoenix terminals, which is used to connect third-party load.

12

1 x 10/100M adaptive ethernet port, RJ45 connector, with led indicator. It can be used to access the

network.

13 1 x 1000M Ethernet port (RJ45), EtherCAT communication interface for connecting to EtherCAT networks.

14

2 x RS485 ports, 6-Pin 3.5mm pitch phoenix terminal, which is used to connect the third-party control

equipment.

15

2 x RS2325 ports, 6-Pin 3.5mm pitch phoenix terminal, which is used to connect the third-party control

equipment.

16

1 x DC input, 2-Pin 3.5mm pitch phoenix terminals with screw holes. It supports 9V~36V input, the signal is

defined as VIN+/GND.

Introducing rear panel interface types and definitions.

1.5.2 Rear Panel
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NO. Function Definition

1 1 x DIN rail mounting bracket, using to mount the ED-PAC3630 unit onto a DIN rail.

2

1 x Micro USB port, it supports to flash to eMMC for the system.

Note: The ED-PAC3630 device comes pre-installed with a valid CODESYS license by default. Reinstalling

the operating system will invalidate the CODESYS license. Do not attempt to install the OS on your own.

3 1 x Nano SIM card slot, reserving for 4G expansion functionality (currently unused).

4 1 x Micro SD card slot, it supports the installation of Micro SD card for storing user data.

Introducing side panel interface types and definitions.

NO. Function Definition

1 1 x Reset button, hidden button, press the button to restart the device.

2 2 x USB 2.0 ports, type A connector, each channel supports up to 480Mbps transmission rate.

3

1 x ​HDMI port, type A connector, which is compatibles with ​HDMI 2.0 standard and supports 4K 60​Hz. It

supports to connect a displayer.

1.5.3 Side Panel
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ED-PAC3630 device includes a RESET button, which is a hidden button, and the silkscreen on the

case is "RESET". Pressing the RESET button will reset the device.

This section explains the status and meanings of the indicators integrated into the ED-PAC3630

device.

​Indicator Status Description

PWR

On The device has been powered on.

Blink

Power supply of the device is abnormal, please stop the

power supply immediately.

Off The device is not powered on.

ACT

Blink

The system started successfully and is reading and writing

data.

Off

The device is not powered on or does not read and write

data.

USER

On User can customize a status according to actual application.

Off

The device is not powered on or not defined by the user, and

the default status is off.

Yellow indicator of Ethernet port

On The data transmission is abnormal.

Blink Data is being transmitted over the Ethernet port.

Off The Ethernet connection is not set up.

Green indicator of Ethernet port

On The Ethernet connection is in the normal state.

Blink The Ethernet connection is abnormal.

Off The Ethernet connection is not set up.

COM1~COM4

On/Blink Data is being transmitted.

Off

The device is not powered on or there is no data

transmission.

X0 ~ X7

On/Blink The input signal has been detected.

Off

The device is not powered on or there is no data

transmission.

CANB0 ~ CANB1 On/Blink Data is being transmitted.

1.6 Button

1.7 ​Indicator
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​Indicator Status Description

Off

The device is not powered on or there is no data

transmission.

Y0 ~ Y7

On/Blink The output signal has been detected.

Off

The device is not powered on or there is no data

transmission.

Introducing the definitions and functions of each interface in the ED-PAC3630.

The ED-PAC3630 device includes one Micro SD card slot, labeled as “ ”, supporting installing a

Micro SD card for user data storage.

ED-PAC3630 device includes one power input, 2-Pin 3.5mm pitch phoenix terminals with screw

holes. The silkscreen of port is “VIN+/GND”, and the pins are defined as follows.

Pin ​ID Pin Name

1 GND

2 9V~36V

The ED-PAC3630 device includes 2 x RS485 interfaces and 2 x RS232 interfaces.

Each RS485 interface is labeled "IGND/A/B".

Each RS232 interface is labeled "IGND/TX/RX".

Terminal pitch: 3.5mm.

Pin Definition

Terminal pins are defined as follows:

Pin ​ID Pin Name

1 RS485-2_B

2 RS485-4_B

3 RS485-2_A

1.8 ​Interface

1.8.1 SD Card Slot

1.8.2 Power ​Interface

1.8.3 RS485/RS232 ​Interface

• 

• 

• 
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4 RS485-4_A

5 GND

6 GND

7 RS232-1_RX

8 RS232-3_RX

9 RS232-1_TX

10 RS232-3_TX

11 GND

12 GND

The pin names of the RS485 and RS232 ports corresponding to CM5 are as follows:

Signal CM5 GP​IO Name CM5 Pin Out

RS485-2_B GPIO13 UART5_RXD

RS485-4_B GPIO9 UART4_RXD

RS485-2_A GPIO12 UART5_TXD

RS485-4_A GPIO8 UART4_TXD

RS232-1_RX GPIO5 UART4_RXD

RS232-3_RX GPIO1 UART2_RXD

RS232-1_TX GPIO4 UART3_TXD

RS232-3_TX GPIO0 UART2_TXD

Connecting Cables

The RS485 wiring schematic is as follows:

The RS232 wiring schematic is as follows:

RS485 Terminating Resistor Configuration
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The ED-PAC3630 includes 2 RS485 channels. A 120Ω terminating resistor is pre-installed

between the A and B lines of each RS485 channel. Inserting a jumper cap enables this terminating

resistor. By default, the jumper cap is not inserted, rendering the 120Ω terminating resistor function

disabled.

The locations of the 120Ω terminating resistors on the PCBA (Printed Circuit Board Assembly) and

their corresponding COM ports are detailed in the table below.

Location on PCBA Corresponding COM Port Physical Position of COM Port

J24 COM4

J22 COM2

TIP

The device housing needs to be opened to locate the position of the 120Ω terminating

resistor.

The ED-PAC3630 device includes 8 digital input (DI) channels.

Every 4 DI channels share 1 common terminal (COM): 

X0, X2, X4, X6 → Share COMX0

X1, X3, X5, X7 → Share COMX1

Terminal pin definitions are as follows:

Pin ​ID Pin Name

1 X0

2 X1

3 X2

4 X3

5 X4

6 X5

7 X6

8 X7

9 COMX0

10 COMX1

Connecting Cables

1.8.4 D​I ​Interface

• 

◦ 

◦ 
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Schematic diagram of a single DI wire is as follows:

Parameter Description

Input Type NPN, PNP

Isolation Protection 5kV

COM

Every 4 DI share one common pin (called COM): 

X0, X2, X4 and X6 share COMX0

X1, X3, X5 and X7 share COMX1

DI to COM
ON state: 5~30 VDC

OFF state: 0~2 VDC

The ED-PAC3630 device includes 8 digital output (DO) channels.

Every 4 DO channels share 1 common terminal (COM): 

Y0, Y2, Y4, Y6 → Share COMY0

Y1, Y3, Y5, Y7 → Share COMY1

Terminal pin definitions are as follows:

Pin ​ID Pin Name

1 Y0

2 Y1

3 Y2

4 Y3

5 Y4

6 Y5

7 Y6

8 Y7

9 COMY0

10 COMY1

• 

• 

• 

• 

1.8.5 DO ​Interface

• 

◦ 

◦ 
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Connecting Cables

Schematic diagram of a single DO wire is as follows:

Parameter Description

Output Type Transistor

Isolation Protection 5kV

COM

Every 4 DI share one common pin (called COM): 

Y0, Y2, Y4 and Y6 share COMY0

Y1, Y3, Y5 and Y7 share COMY1

Output 5~30 VDC (24 VDC is recommended), maximum current is 1.5A (per channel)

WARNING

If an inductive load is connected to the DO channel, it is recommended to add a Diode in

the circuit (as shown in the figure below) for protection. Select an appropriate Diode based

on the specifications of the inductive load.

The ED-PAC3630 device includes 2 channels of CAN interfaces. The terminal pin definitions are

as follows:

Pin ​ID Pin Name

• 

• 

1.8.6 CAN ​Interface
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1 CANB0​H

2 CANB1​H

3 CANB0L

4 CANB1L

5 GND

6 GND

Connecting Cables

Schematic diagram of CAN wires is as follows:

The ED-PAC3630 device includes 1 auto-sensing 10/100/1000M Ethernet port, labeled as " ".

Connector type: RJ45.

Default configuration: EtherCAT communication interface, supporting connection to EtherCAT

networks.

Recommended cable: Category 6 (Cat6) or higher Ethernet cables for optimal performance.

The ED-PAC3630 device includes 1 auto-sensing 10/100M Ethernet port, labeled as " ".

Connector type: RJ45.

Recommended cable: Category 6 (Cat6) or higher Ethernet cables for optimal performance.

The ED-PAC3630 device includes 1 ​HDMI port, labeled as "​HDMI", which is a standard Type-A

connector. It supports connecting to ​HDMI displays and delivers video output up to 4K resolution

at 60​Hz (4K@60​Hz).

The ED-PAC3630 device includes 2 x USB 2.0 ports, labeled as “ ”, which are standard Type-

A connectors. They support to connect USB 2.0 peripherals, the maximum transfer rate is

480Mbps.

1.8.7 1000M Ethernet ​Interface (EtherCAT)

• 

• 

• 

1.8.8 100M Ethernet ​Interface

• 

• 

1.8.9 HDM​I ​Interface

1.8.10 USB 2.0 ​Interface
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The ED-PAC3630 devices include one Micro USB port, labeled as "PROGRAMMING". It is used to

connect to a PC for programming the device's eMMC storage.

WARNING

The ED-PAC3630 device comes pre-installed with a valid CODESYS license by default.

Reinstalling the operating system will invalidate the CODESYS license. Do not attempt to

install the OS on your own.

The ED-PAC3630 integrates a supercapacitor backup power supply with the following

functionalities:

Power-Loss Data Retention:

When the device loses power unexpectedly, the supercapacitor provides temporary power to

critical circuits.

Duration: 

Up to ~1 minute under light loads.

~30 seconds under heavy loads.

Ensures critical data (e.g., program states, counter/timer values) is preserved during sudden

outages.

Vital for industrial applications requiring rapid recovery and zero data loss after power

restoration.

Real-Time Clock (RTC) Maintenance:

Powers the RTC circuit during main power failures to maintain accurate timekeeping.

Essential for timestamping events and maintaining operational logs.

Orderly Shutdown Support:

Enables controlled shutdown procedures during power loss.

Provides energy to safely: 

​Halt active processes (e.g., complex computations).

Close communication ports.

Deactivate functional modules per predefined protocols.

TIP

The supercapacitor requires at least 5 minutes of charging after the device is powered on

to ensure full functionality.

1.8.10 Micro USB ​Interface

1.9 ​Introduction to Supercapacitor
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The ED-PAC3630 supports DIN rail installation. A DIN rail mounting bracket is pre-installed as

standard.

Steps:

Position the device with the side containing the mounting bracket facing the DIN rail to be

installed. ​Hook the upper part of the bracket onto the top edge of the DIN rail.

Press down on the locking tab at the lower part of the bracket until it snaps into place on the

DIN rail, completing the installation.

2 ​Installing The Device

1. 

2. 
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This chapter details the specific procedures for connecting cables and powering on the device.

This section describes the procedures for connecting cables to the device.

Preparation:

Available functional accessories: Monitor, mouse, keyboard, I/O expansion module, and power

adapter.

Available functional network connection.

Available functional cables: ​HDMI cable and Ethernet cable.

Schematic diagram of connecting cables:

Please refer to 1.8 Interface for the pin definition of each interface and the specific method of

wiring.

The ED-PAC3630 has no power switch. When connected to power, the system will begin booting.

Red PWR indicator: Lights up to indicate the device is receiving power.

3 Booting The Device

3.1 Connecting Cables

• 

• 

• 

3.2 Booting The System For The First Time

• 
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Green ACT indicator: Blinks to signal normal system startup. The Raspberry Pi logo will then

appear in the upper-left corner of the screen.

TIP

Default username is pi , default password is raspberry .

If the device is factory-installed with the Desktop OS, it will boot directly into the desktop interface

upon startup, as shown in the figure below.

If the device is factory-installed with the Lite OS, it will automatically log in using the default

credentials after startup. The figure below indicates that the system has booted successfully.

• 

3.2.1 Raspberry Pi OS (Desktop)

3.2.2 Raspberry Pi OS (Lite)
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This chapter details the specific operations involved in using CODESYS.

WARNING

The ED-PAC3630 device comes pre-installed with a valid CODESYS license by default.

Reinstalling the operating system will invalidate the CODESYS license. Do not attempt to

install the OS on your own.

TIP

The installed CODESYS IDE version must be 3.5.19 or higher, and the PC operating

system must be Windows 10 or Windows 11 (64-bit recommended).

Download the installation package from the official CODESYS website. The download URL is 

https://store.codesys.com/de/ (https://store.codesys.com/de/) .

TIP

When downloading from the CODESYS official website for the first time, you must first

register and log in to your account.

Right-click the downloaded installer and select "Run as administrator" from the context menu.

Click "Install" in the opened installation interface, and keep the default configuration during the

installation process.

After the installation is complete, click "Finish" to close the installation interface.

4 CODESYS Programming

4.1 CODESYS Software Download and ​Installation

1. 

2. 

3. 

4. 
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Before connecting to the device via CODESYS, you need to download and install the device

description file first.

TIP

The default IP addresses for the device are:

100M Ethernet port: 192.168.1.100

1000M Ethernet port (EtherCAT port): 192.168.0.100 If you need to modify these

settings, refer to Configuring Ethernet IP.

Preparation:

A CODESYS-authorized ED-PAC3630 is available.

A functional Ethernet cable is available.

A Windows PC is prepared, with its IP address configured to the same subnet as the device.

For example, if the device’s IP (1000M Ethernet port) is 192.16​8.0.100 , set the PC’s IP to 

192.16​8.0.99 .

Steps:

Connect the device's 1000M Ethernet port to the PC via an Ethernet cable, then power on the

device.

Enter http://192.16​8.0.100:​8100  in the PC’s web browser to access the "PLC Setting"

interface.

In the "Device Info" section, click the "​​[Download] Device Description File" button to download

the corresponding ".xml" format device description file.

4.2 Obtaining and ​Installing Device Description File

4.2.1 Obtaining Device Description File

• 

• 

• 

• 

• 

1. 

2. 

3. 
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TIP

The device files are available for download within the documentation. Different CODESYS

licenses correspond to different device files. For specific descriptions and download paths,

please refer to Device File and Function Correspondence Table.

Preparation:

A PC installed with CODESYS software version V3.5 SP19 (64-bit).

An ED-PAC3630 device with a valid CODESYS license and its corresponding device

description file.

Connect both the PC and ED-PAC3630 to the network, ensuring their IP addresses are within

the same subnet.

Steps:

Double-click the CODESYS icon on the PC desktop to open the CODESYS software. From the

menu bar, select “Tools” → “Device Repository”.

In the opened "Device Repository" pane, click "Install".

4.2.2 ​Installing Device Description File

• 

• 

• 

1. 

2. 
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In the pop-up "Install Device Description" pane, select the device description file to be installed

and click "Open" to proceed with the installation.

After successful installation, you can verify in the "Device Repository" that the device

description file have been added successfully.

TIP

If the you need to control DI, DO, or other GPIOs on the device via CODESYS, it is

recommended to install the GPIO description file.

3. 

4. 

4.2.3 ​Installing GP​IO Description File
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Preparation:

A PC installed with CODESYS software version V3.5 SP19 (64-bit).

A CODESYS-authorized ED-PAC3630 device available.

GPIO description file obtained, with the download link: GPIO Description File (https://vip.

123pan.cn/1826505135/17966990) .

Connect both the PC and ED-PAC3630 to the network, ensuring their IP addresses are within

the same subnet.

Steps:

Double-click the CODESYS icon on the PC desktop to open the CODESYS software. From the

menu bar, select “Tools” → “Device Repository”.

In the opened "Device Repository" pane, click "Install".

In the pop-up "Install Device Description" pane, select the GPIO description file to be installed

and click "Open" to proceed with the installation.

After successful installation, you can verify in the "Device Repository" that the GPIO description

file have been added successfully.

• 

• 

• open in new window

• 

1. 

2. 

3. 

4. 
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Preparation:

A PC installed with CODESYS software version V3.5 SP19 (64-bit).

A CODESYS-authorized ED-PAC3630 device available.

Remote I/O device description file obtained, with the download link: Remote I/O Description File

(https://vip.123pan.cn/1826505135/16632390) .

Connect both the PC and ED-PAC3630 to the network, ensuring their IP addresses are within

the same subnet.

Steps:

Double-click the CODESYS icon on the PC desktop to open the CODESYS software. From the

menu bar, select “Tools” → “Device Repository”.

In the opened "Device Repository" pane, click "Install".

4.2.4 ​Installing Remote ​I/O Device Description File

• 

• 

• open in new window

• 

1. 

2. 
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In the pop-up "Install Device Description" pane, select the I/O device decirption file to be

installed and click "Open" to proceed with the installation.

After successful installation, you can verify in the "Device Repository" that the I/O device

description file have been added successfully.

Preparation:

A PC with CODESYS software version V3.5 SP19 (64-bit) installed, configured to operate on

the same subnet as the device.

Device description file, remote I/O device description file, and GPIO description file have been

installed.

The remote I/O modules have been connected to the ED-PAC3630's EtherCAT port (Gigabit

Ethernet port) via network cable. Configure the IP addresses of the PC, ED-PAC3630, and

remote I/O within the same subnet.

3. 

4. 

4.3 Hardware Configuration

• 

• 

• 
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Steps:

Power on the ED-PAC3630 and the remote I/O modules. Open the CODESYS software on the

PC, select "File" → "New Project" in the menu bar to open the "New Project" pane, and create a

standard project.

Select the installed device description file and click "OK".

Double-click the device, select "Scan Network" on the right, then choose the detected device

from the scan results, and click "OK" to confirm.

4.3.1 Create a New Project and Connect to the Device

1. 

2. 

3. 
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TIP

If the device cannot be detected during scanning, manually enter the IP address in the

target device settings to connect.

If a device login prompt appears, log in with your credentials (username and password)

or follow the instructions to register a new account.

As shown in the figure below, this indicates the device is successfully connected.

Steps:

Right-click “Device” and select “Add Device” in the menu to add the EtherCAT Master.

• 

• 

4. 

4.3.2 Adding Remote ​I/O Modules

1. 
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Double-click on the EtherCAT Master device to set the source address (Select the EtherCAT

port, which corresponds to the device's eth0 port).

Click the  button to log in to the device. A successful login is shown in the figure below.

Click on the EtherCAT Master device, select “Scan for Devices” in the right-click menu, and

copy all devices to the project after scanning is completed.

2. 

3. 

4. 
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Click the  button to log out of the device.

Double-click the slave device, configure the relevant parameters in the right-hand interface,

enable "Expert settings", select "Enable" under Select DC section, and select "Enable Sync0".

Click the  button to download the program to the device, then click the  button to run it. As

shown in the figure below, this indicates a successful operation.

Right-click “Device” and select “Add Device” in the menu to add ED-GPIO.

5. 

6. 

7. 

4.3.3 Adding GP​IO Module

1. 

ED-PAC3630

Email: sales@edatec.cn / support@edatec.cn

Web: www.edatec.cn
| Phone: +86-15921483028(China) | +86-18217351262(Overseas)



Right-click "ED_GPIO", select "Add Device" from the menu, and choose the device to be

added.

The appearance of the corresponding device under the ED_GPIO device directory indicates a

successful addition.

Double-click the GPIO device to view and control the GPIO in the right-hand interface.

2. 

3. 

4. 
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TIP

The GPIO numbering may vary between devices. It is recommended to access the "PLC

Setting" interface (http://192.168.0.100:8100) to view the device-specific GPIO numbering.

The following example demonstrates practical programming using a specific coding scenario.

4.4 Programming
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Complete the development and debugging of a program for a timed blinking LED using a PNP-

type 8-channel digital output (DO) module.

Preparation:

A standard project has been created.

​Hardware configuration has been completed.

A 24V compact LED lamp has been connected to the first output port of the remote DO (Digital

Output) module.

Steps:

Double-click the DO module, select "Module I/O Mapping" → "Output" in the right-hand

interface, and view the addresses of all output ports. As illustrated below, the first output port’s

address is %QX1​8.0 .

4.4.1 Programming Process

4.4.2 Programming Example

• 

• 

• 

1. 
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Click "PLC_PLG" to open the programming interface, where the upper section is the variable

declaration area and the lower section is the main program editing area.

Write the program code as follows:

2. 

3. 

    PROGRAM PLC_PRG

VAR

TON_TIME : TON; 

Light_Output : BOOL := FALSE; 

END_VAR

TON_TIME(IN := NOT TON_TIME.Q, 

         PT := T#0.5S); 

sh

sh
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After completing the program, click " " to compile it and ensure there are no errors.

Click Login to download the program to the device, then click Run to observe the LED blinking

every 0.5 seconds.

After downloading the program to the device, you can perform the Run and Stop operations.

Status Operations

Run Program In the main menu of the software interface, click the Login  button

4. 

5. 

4.5 Operation and Maintenance

IF TON_TIME.Q THEN 

    Light_Output := NOT Light_Output; 

    TON_TIME(IN := FALSE); 

END_IF

%QX1​8.0:= Light_Output; 
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Status Operations

Stop Program In the main menu of the software interface, click the stop  button.
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This chapter introduces how to configure system.

WARNING

The ED-PAC3630 device comes pre-installed with a valid CODESYS license by default.

Reinstalling the operating system will invalidate the CODESYS license. Do not attempt to

install the OS on your own.

Finding Device IP

Remote Login

Configuring Storage Devices

Configuring Ethernet IP

Configuring Buzzer

Configuring RTC

Configuring USER Indicator

This chapter introduces the configuration method of RS232 and RS485.

5 Configuring System

5.1 Finding Device ​IP

5.2 Remote Login

5.3 Configuring Storage Devices

5.4 Configuring Ethernet ​IP

5.5 Configuring Buzzer

5.6 Configuring RTC

5.7 Configuring USER ​Indicator

5.8 Configuring Serial Port
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In the Linux environment, you can use the picocom tool to debug the serial ports RS232 and

RS485.

Execute the following command to install the picocom tool.

ED-PAC3630 includes 2 RS232 ports with corresponding COM ports and device files, as shown in

the table below:

Number of RS232 Ports Corresponding COM Port Corresponding Device File

2 COM1, COM3 /dev/com1, /dev/com3

Preparation:

The RS232 ports of ED-PAC3630 has been connected with external device.

Steps:

Execute the following command to open the serial port com1, and configure the serial port baud

rate to 115200.

Input commands as needed to control external device.

ED-PAC3630 includes 2 RS485 ports with their corresponding COM ports and device files, as

shown in the table below:

Number of RS485 Ports Corresponding COM Port Corresponding Device File

2 COM2, COM4 /dev/com2, /dev/com4

Preparation:

The RS485 ports of ED-PAC3630 has been connected with external device.

Steps:

Execute the following command to open the serial port com4, and configure the serial port baud

rate to 115200.

5.8.1 ​Installing Picocom Tool

5.8.2 Configuring RS232

1. 

2. 

5.8.3 Configuring RS485

1. 

sudo apt-get install picocom

picocom -b 115200 /dev/com1

sh

sh
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Input commands as needed to control external device.

ED-PAC3630 includes 8 DI ports, which can be configured according to the actual requirement.

Preparation:

The connection of the DI port of the ED-PAC3630 to the external sensor has been completed.

Steps:

Execute the following commands in sequence to detect and install the gpiod tool.

Execute the following command to read the data from the corresponding DI port.

DI0  indicates the corresponding port number.

ED-PAC3630 includes 8 DO ports, which can be configured according to the actual requirement.

Preparation:

The connection of the DO port of the ED-PAC3630 to the external load has been completed.

Steps:

Execute the following commands in sequence to detect and install the gpiod tool.

Execute the following commands to set the output to high or low.

Setting the output to a high level.

2. 

5.9 Configuring D​I

1. 

2. 

• 

5.10 Configuring DO

1. 

2. 

• 

picocom -b 115200 /dev/com4

sudo apt update

sudo apt install gpiod

gpiofind DI0 | awk '{print substr($0,9)}' | xargs -i bash -c "gpioget {}"

sudo apt update

sudo apt install gpiod

sh

sh

sh

sh
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DO0  indicates the corresponding port number, 1  indicates that the pin is high level.

Setting the output to a low level.

DO0  indicates the corresponding port number, 0  indicates that the pin is low level.

Execute the following commands in sequence to detect and install the can-utils tool.

Preparation:

The connection of the CAN port of the ED-PAC3630 to external devices has been completed.

Steps:

Execute the following command to set the baud rate of the CAN port to 1000000.

 canb0  is the port number and the values include canb0  and canb1 .

Execute the following command to open the CAN port.

• 

5.11 Configuring CAN

5.11.1 ​Installing can-utils Tool

5.11.2 Setting CAN State

1. 

2. 

gpiofind DO0 | awk '{print substr($0,9)}' | xargs -i bash -c "gpioset {}=1"

gpiofind DO0 | awk '{print substr($0,9)}' | xargs -i bash -c "gpioset {}=0"

sudo apt update

sudo apt install can-utils

sudo ip link set canb0 type can bitrate 1000000

sudo ip link set canb0 up

sh

sh

sh

sh

sh
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 canb0  is the port number and the values include canb0  and canb1 .

Execute the following command to set up the CAN port for communication.

Receive data:

Send data:

canb0  is the port number and the values include canb0  and canb1 .

123#11223344556677​8​8  is the message to be sent, which can be customised by the user

according to the format.

The ED-PAC3630 device comes pre-installed with a CODESYS license by default. You can back

up and restore the license by accessing the "PLC Setting" interface.

Preparation:

A Windows PC has been set up with an IP address in the same subnet as the device. For

example, if the device’s IP (1000M Ethernet port) is 192.16​8.0.100 , set the PC’s IP to 

192.16​8.0.99 .

A functioning Ethernet cable has been prepared.

Steps:

Connect the device's 1000M Ethernet port to the PC via an Ethernet cable, then power on the

device.

Enter http://192.16​8.0.100:​8100  in the PC’s web browser to access the "PLC Setting"

interface.

In the "Codesys License Management" interface, click "Backup License" to download the

license file and save it locally.

3. 

• 

• 

5.12 CODESYS License Management

5.12.1 License Backup

• 

• 

1. 

2. 

3. 

candump canb0

cansend canb0 123#11223344556677​8​8

sh

sh
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TIP

The backed-up license file can only be restored on the same device.

Preparation:

A Windows PC has been set up with an IP address in the same subnet as the device. For

example, if the device’s IP (1000M Ethernet port) is 192.16​8.0.100 , set the PC’s IP to 

192.16​8.0.99 .

A functioning Ethernet cable has been prepared.

The backed-up license file has been obtained.

Steps:

Connect the device's 1000M Ethernet port to the PC via an Ethernet cable, then power on the

device.

Enter http://192.16​8.0.100:​8100  in the PC’s web browser to access the "PLC Setting"

interface.

In the "Codesys License Management" interface, click "Restore License".

5.12.2 License Restore

• 

• 

• 

1. 

2. 

3. 
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As prompted, select the obtained license file under a custom path.

After a successful License Restore, a 100% progress bar will be displayed in the right-hand

panel.

Open the device’s terminal command pane, execute the following command, and restart the

device.

4. 

5. 

6. 

sudo reboot

sh
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